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SPRACHE IN Paragraph-Style “05 - STANDARD Fließtext” passend einstellen

1	 Introduction
Welcome to the Guitar Rig 4 Application Reference!

1.1	 About this Manual

This manual covers all elements of GUITAR RIG 4 in detail. If you want to get deeply into 
the software, this is the document to refer to. 

The following documents are also available:
►► The Setup Guide tells you how to install, activate and configure GUITAR RIG 4 on your 

system.

►► The Getting Started guide provides you with essential information needed to use 
GUITAR RIG 4 and explains how to accomplish fundamental tasks.

►► To learn about each and every knob that controls the amps, distortion pedals and 
other components for shaping and modulating GUITAR RIG’s sounds, refer to the 
Components Reference.

►► If you have obtained GUITAR RIG 4 in a hardware bundle (MOBILE/SESSION/
KONTROL), please read the according Hardware Reference to correctly set up your 
hardware and software.

All the manuals can be accessed through the program menu by selecting Help > Open 
Manual > Your Language.

Visit the community forums at native-instruments.com/forum, where beginners and expe-
rienced users exchange knowledge on Native Instruments products every day.

Safety Considerations

http://www.native-instruments.com/forum
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GUITAR RIG 4 — in combination with headphones or amplifier-driven speakers — can 
produce volumes that may cause hearing damages. For your protection, set all volume 
levels to a minimum before using GUITAR RIG 4. Gradually raise the volume controls while 
music is playing to set the desired listening level. If you experience any hearing problems 
or persistent ringing in the ears, consult an audiologist immediately.
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2	 User Interface
Learn everything about the GUITAR RIG 4 user interface in the following sections.

The user interface of Guitar Rig 4 in Standard view: Preset Browser and a basic Rack

2.1	 Global Header

The Global Header (visible both in Standard view and in Live view) assembles the main 
input and output controls as well as the system performance display of GUITAR RIG 4.

Apart from these, the Live button is situated in the Global Header. It activates Live view, 
which has been optimized for on-stage use – see section 2.2 for more information.
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2.1.1	 Input & Output
From left to right, the following global input and output controls are available:

►► The L/R buttons control the input routing of the software. By default, both input chan-
nels are processed. If one channel is deactivated by clicking on its button, the other’s 
(mono) signal will be routed to both of GUITAR RIG’s stereo channels. This is recom-
mended if you are processing a single guitar or bass.

►► The Input Meter shows the amplitude of the incoming signal and features an inte-
grated volume fader that controls the input level of the software. It should be ad-
justed so that the Input Meter gets close to, but never hits the red zone, which is in-
dicating overload.

►► The Gate button operates a basic noise Gate, killing hiss when you are not playing. 
Turn it on and off by clicking on the button, adjust the threshold to your actual re-
sidual noise level with the knob right of it. When double-clicking the threshold knob, 
a learn function to automatically set the optimum threshold is it activated. Do not play 
your instrument for some seconds: GUITAR RIG 4 analyzes your signal and sets the 
threshold just above any residual noise.

►► The Output Meter  shows the amplitude of the software’s output and features an in-
tegrated volume fader that controls the output level. It should be adjusted so that the 
limiter is never triggered, indicated by the Output Meter hitting the orange zone.

►► The Limiter  is preventing the output level from reaching overdriven and possibly harm-
ful volume peaks. You can turn it off by clicking on the button anytime, overdrive will 
then be indicated by red LEDs.
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2.1.2	 System Performance
The right-most section shows information about your system’s performance:

►► Your CPU load is constantly measured – it should not go above 70% to avoid clicks 
and interruptions.

►► If it is necessary to save some CPU power without limiting the number of components, 
you can deactivate High Quality Mode by clicking on the Hi button. High Quality Mode 
means that the current sample rate is doubled using oversampling, resulting in a 
higher “resolution” of the sound.

►► Clicking on the Power button completely bypasses the sound processing of GUITAR 
RIG 4, changing the CPU display to “BYP”.

►► When no audio driver is selected, the CPU display shows “OFF”.

►► If a CPU overload occurs, the display shows “OVER” and the Power button turns red 
– the audio engine has been disabled. You might need to disable some components 
or turn off high quality mode to save CPU power. Then re-activate the audio engine 
by clicking the Power button.
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2.2	 Live View

Guitar Rig 4 in Live view

Clicking on the Live button in the Global Header or pressing F1 switches from the Standard 
view to the Live view. It hides the Rack and instead puts the most important performance 
features into a clear layout.

The Live view is perfect for on-stage use, consolidating the following elements:

►► Global Header

►► Current Preset List as defined in the Preset Browser

►► Currently selected preset with information 

►► Metronome, Tuner, and Loop Machine (optional)

►► Large Virtual Rig Kontrol display with all assignments
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Metronome, Tuner and Loop Machine
You can activate these Live view options by clicking on the buttons labeled Metronome, 
Tuner and Loop Machine. Whenever your trigger the Tuner via controller inputs, the cor-
responding view will automatically be activated.

2.3	 Toolbar and Rack

If you are in Live view, please return to Standard view by clicking on the Live button to 
continue our tour through the user interface of GUITAR RIG 4.

The Rack with Metronome, Tapedeck Pre, Tuner, Preset Volume and Virtual Rig Kontrol

The Toolbar sits on top of the Rack and is your one-stop-shop for all the Rack Tools and 
some other frequently used features.

►► The left-most box shows the currently activated preset. You can step through the cur-
rent Preset List by clicking on the Up/Down arrows, even if it is not visible.
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►► The middle buttons toggle the display of the Virtual Rig Kontrol (see section 2.4) and 
all the Rack Tools: Tapedeck Pre (for playing back), Tapedeck Post (for recording), 
Tuner and Metronome (for synchronizing effects and yourself). See section 5 for details 
on the Rack Tools.

►► On the right side, the x (cross) will empty the rack of all components with one click 
–this can of course be undone by selecting Edit > Undo from the program menu or 
by pressing CTRL+Z (Win)/ CMD+Z (Mac).

►► Clicking on the - (minus) minimizes all rack modules. It then turns into a + (plus), al-
lowing to restore the previous view.

The Rack itself holds all components that are processing your sound – giving a clear over-
view of the signal flow. It is the heart of GUITAR RIG 4’s functionality, and incredibly easy 
to use with drag and drop. See section 4 for all details.
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2.4	 Virtual Rig Kontrol

The Virtual Rig Kontrol is shown after clicking on its button in the Toolbar or pressing 
F3. It is a graphical representation of the RIG KONTROL foot controller, indicating which 
functions are assigned to its buttons and the foot pedal. See section 6 for an exhaustive 
explanation.

The buttons and the foot pedal can also be operated directly with the mouse, if no RIG 
KONTROL is connected. Even if you are not using the RIG KONTROL, you can assign ex-
ternal MIDI controllers to the Virtual Rig Kontrol to benefit from its integration, especially 
in Live view. See section 8.1.3 for details.
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2.5	 SideKick

About a third of the user interface is occupied by the SideKick, a multi-functional area on 
the left hand side of the screen.

The SideKick in its three different functions

It displays different content, depending on which of the tab buttons (Browser, Components 
or Options) is activated. The SideKick is not necessary all the time and can be hidden by 
clicking on the Arrow button situated next to the tab buttons, or by pressing F2.

►► The Preset Browser allows filtering of all available Rack Presets on three levels; you 
can organize your presets and perform a text search to easily find your presets. See 
section 3 on working with presets.

►► The Component Pool contains all available components along with their presets, ready 
for dragging them into the Rack. Their complete explanations can be found in the 
Components Manual, but you will find out most of it by just trying them out. See 
section 4 on building up your rack.

►► The Options screen serves to configure external controllers and their assignments, as 
well as preferences such as the window height, the path to presets and other details. 
See section 8 on setting up MIDI controllers and all the options.
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3	 Working with Presets
GUITAR RIG 4 would only be half as useful without a sophisticated management system to 
help you find and organize all available presets. A completely reworked, tag-based Preset 
Browser and a powerful search function make navigating through presets and manag-
ing them a joy, and Component Presets allow for a convenient modular approach to rack 
building.

At this point, it is important to understand that there are two different kinds of presets in 
GUITAR RIG 4:

Rack Presets
Rack Presets allow you to store and recall complete Rack setups and organize them in a 
convenient way using the Preset Browser. Each Rack Preset consists of a chain of com-
ponents with their exact configuration that is loaded into the Rack when the preset is 
activated. At the same time, it preserves the tempo and all controller assignments.

The latter can be overridden when the preset is loaded. This depends on the following 
settings:

►► The Metronome’s Sync control is set to Ext or Free: This prevents the Metronome’s 
tempo to change when loading a preset. Set it to Sound if you want the tempo setting 
to be loaded with the Rack Preset.

►► The assignments of the Virtual Rig Kontrol and other controllers can be globally locked 
(see section 6.2 and 8.1.2), which is indicated by a small padlock symbol. These will 
not be affected by controller assignments stored in a Rack Preset.

GUITAR RIG 4 ships with a huge amount of Rack Presets of any style, and you can easily 
create more as you see fit.
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Component Presets
A Component Preset contains all settings for one single component, such as the exact 
knob positions of an amp producing your favourite crunch tone. After highlighting one of 
the items in the Component Pool, all its available presets are shown in a list below. Use 
Component Presets to store and recall your favorite delay setting or try a special amp 
sound in another rack’s context. As Component Presets are a tool for building your Rack, 
you find all details in section 5.2.

3.1	 The Preset Browser

Click on the Browser button to open the Preset Browser – a powerful tool for finding and 
organizing all your Rack Presets.
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3.1.1	 Tags and the Preset List
Three columns with several tags, entitled Preset Attributes, define which presets are shown 
in the Preset List below. You can select and deselect tags by clicking on them once. If no 
tag is highlighted (orange), all available presets are shown.

►► Click on a tag in the left column to select it: The Preset List is instantly reduced to 
the presets containing this tag.

►► If the tag you chose contains sub-tags, they can be selected in the middle column.

►► Sub-tags of the third level appear in the right column, if present.

►► Consequently, sub-tags disappear if you deselect the tag they belong to by clicking on 
it.

►► You can select multiple tags by holding SHIFT or CTRL while you click.

The Preset List itself sports 3 columns: List Number (#), Name and Rating. Note that 
you can resize the height of the list by dragging the resize handle just below the search 
bar. Clicking on the column headers will sort by the according values, first ascending then 
descending.
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The Rating system is very helpful for keeping order in your growing archive: Give your pre-
sets a quality rating from 1-5 stars by clicking on one of the 5 dots right beside its name. 
It will instantly be stored with the preset, to help your memory and – after doing this with 
all your presets – provide you with a powerful Preset List: Sort it by rating!

3.1.2	 The Search Engine
The new search engine will help you to quickly find a particular preset by entering part of 
its name. The search bar is situated below the Preset Browser and always ready to process 
your requests.

It works incrementally: With every letter you type in, it will narrow down the Preset List 
below by only showing presets that contain the string you entered. Clicking on the x (Cross) 
clears the search bar.



Application Reference – 21

3.1.3	 Loading and Saving Rack Presets
Loading Rack Presets works plain simple from the Preset List: Just double-click on the 
name of the preset you want to load. If you press ALT while doing so, all the components’ 
Stereo buttons will be engaged regardless of their stored settings – so your complete Rack 
will be processing audio in true stereo.

Any changes you make now won’t automatically be saved to the preset. If you want them 
to be permanent, click on Save on the bottom of the SideKick.

3.1.4	 Saving New Rack Presets
If you want to save your current rack to a new preset, click on Save as.

You are now presented with a special page in the SideKick, where you can enter the pre-
set’s name, author, rating and some notes to save with it.
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The preset will be saved with all tags which are currently selected in the upper part of 
the Preset Browser. You can still change them on the Save As page, before you press Save 
again to confirm. To delete a preset, right-click on it in the Preset List and select Remove 
from disk.

3.1.5	 Tags on Three Levels
The tags under Preset Attributes are hierarchic, getting more precise from left to right. 
Each tag of the first and second level can contain sub-tags that further narrow down what 
you are looking for.

Creating and Deleting Tags
You can create and relate tags to organize your presets exactly as you want. As each preset 
can appear under multiple tags of different levels, you have a lot of organizational power 
at hand. Use tags to characterize and group your sounds on up to three levels: To order 
them by musical genres or pickup types, or to create set-lists for live use.

►► Tags can be created by double-clicking into an empty field or by right-clicking into a 
column and selecting Create a new tag.

►► Tags in the second and third column can be created only if a tag is selected left of 
them – they are sub-tags to the ones on the higher level!

	

►► To delete a tag, click on it so that it is highlighted in orange (selected). Then right-click 
anywhere in the Preset Browser. Select Delete this tag to delete the selected tag and 
all of its sub-tags.
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►► No preset will be harmed by deleting a tag – all presets are still in the Preset List 
when no tag is selected. To delete a preset, right-click on it in the Preset List and 
select Remove from disk.

Example
Let us create an exemplary three-level tag which you could add to all the presets you 
are currently preparing to use on stage with your band: “Your Band – Live-Presets – In 
Progress“.

►► Create a new tag simply by double-clicking on an empty field in the first column. Type 
in a text label (e.g. your bandname) and press ENTER.

►► Click on the newly created tag to select it – it must be highlighted in orange. Double-
click into the middle column and create a new tag (e.g. “Live-Presets”). This is your 
first sub-tag; another useful one could be “Studio-Presets”.

►► Sub-tags are only visible in relation to their higher-level tags. If you deselect “Your 
Band” on the first level by clicking on it again, all of its sub-tags disappear.

►► Creating a sub-tag on the third level works exactly the same way, just highlight “Live-
Presets” and create a new tag called “In Progress” in the right-most column.
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3.1.6	 Tagging Presets
Any preset can carry an unlimited number of tags! Adding tags to presets works simply 
with drag and drop:

►► Click on one of the presets in the Preset List and drag it onto one of the tags in the 
left column of the Preset Browser.

	

►► While dragging and holding down the mouse button, you can navigate through sub-
tags to further specify the precise tag you want to add. The moment you release the 
mouse button to drop the preset on a tag (no matter on which level), the tag is added 
to the preset.

►► Because of the hierarchical structure of the tagging system, adding a sub-tag auto-
matically adds its higher-level tag(s) to the preset.

►► Drag and drop adds new tags to the preset without deleting the previous ones: The 
preset will be listed both under the tag that was activated before you dragged it, and 
under the new tag.

►► To remove the currently selected tag from a preset, just delete the entry from the 
Preset List below. Make sure the correct tag (with sub-tags) is selected, click on the 
preset in the Preset List, and press DEL (Win) / CMD+BACKSPACE (Mac). Or right-
click and select Remove from this list.
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►► An easy way to remove a preset from many Preset Lists is to use the Info Page (see 
section 3.2).

►► After removing all tags from a preset, it is still available in the Preset Browser when 
you de-select all tags.

►► To really delete a preset, highlight it, right-click and select Remove from disk.
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3.2	 Preset Info Page

After clicking on Info, the following information is shown for the currently selected preset.

All the fields can be edited after clicking into the field beneath the label once.

►► Author: The last name you entered in the Save as...  dialogue will be used as default.

►► Rating: Click on the dots / stars to change the rating.

►► Notes: These Will be shown in Live view – a good place for your cheat slip! 

►► Preset Attributes: This shows all tags stored with the currently selected preset at a 
glance. After selecting one of the tags, the Preset List will change showing all the 
presets containing this tag. Deleting a preset from the Preset List will remove the cur-
rently selected tag from it.

►► The date the Preset was last modified and saved.
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4	 Components and the Rack

4.1	 Building a Rack from Scratch

On the first start, the Rack of GUITAR RIG 4 is empty, you will hear dry, slightly pre-
amplified guitar sound when you play: an invitation to try out the various components all 
by yourself.

The empty Rack

On future starts, the software will always retain the last state of the Rack before you closed 
it. Click on the x (Cross) in the Toolbar, if you want to start from scratch again!
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4.1.1	 The Component Pool
Open the Component Pool by clicking on Components in the SideKick. It contains all sound-
shaping and modulating components and their Component Presets, ordered by 8 catego-
ries. Click on their label to see the available components listed below! Note the scrollbar 
if there are more than 12 entries.

►► Amps: Guitar and bass amps, as well as the cabinet components

►► Dist: Distortion, Overdrive and Fuzz pedals

►► Mod: Time- and pitch-based modulation effects and synthesizers (Flanger, Octaver, 
etc.)

►► EQ: Equalizers, filters and wah-wah pedals

►► Vol: Volume-based effects (Compressor, Noise Gate, etc.)

►► Rev: Reverbs and Delays

►► Tools: Loop Machine and tools for parallel signal processing

►► MDF: Modifiers allowing for elaborate parameter modulation of other components

When you select any component by clicking on it, it is highlighted, and a list of all available 
Component Presets is shown below. Learn more about Component Presets in section 3.5.2.

To show some information on this particular component, click on the Info button on the 
bottom of the SideKick.

4.1.2	 Setting up an Amp
The fastest way to start designing sounds with GUITAR RIG 4 is by adding an amp to the 
Rack. If you want to quickly create a guitar sound, try the Lead 800.

►► Double-click the amp’s icon in the Component Pool to quickly add it to the (end of 
the) Rack. You can also drag it right where you want it to be.

►► The amplifier and a Matched Cabinet will be inserted into the Rack simultaneously. 
The Matched Cabinet is only added automatically if no cabinet is present below the 
destination of the amp.
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If you play now, you will hear that famous british sound.

	

	 Lead 800 with Matched Cabinet

►► To change the cabinet, click on it once, to highlight the component in the Rack. Then 
go to the Component Pool, section Amps, and double-click the Cabinet & Mics or the 
all-new Control Room module, to replace it.

	

	 A double-click in the Component Pool will replace the Matched Cabinet (highlighted) in the Rack
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►► All the knobs and switches you see are effectively controlling the amp’s sound. Clicking 
with the mouse flips the switches, clicking and dragging the mouse up and down (while 
holding the mouse button down) turns the knobs. 

►► If you want to check out some amp settings recommended by our sound designers, 
try Component Presets to configure the Hot Plex. Click on the Component Preset 
display  to jump to the Component Pool.

►► The Hot Plex is automatically selected in the Component Pool. Double-click one of 
the Component Presets listed below to load it.

4.1.3	 Basics for Rack Building
Now you can tweak the amp yourself, add distortion modules, modulating effects or try 
out whatever you please! The audio signal runs through the chain of rack modules from 
top to bottom, except if you are using special tools that create parallel processing paths, 
like the Split. See the Components Reference for details on these tools.

Rack Usage
►► You can add components to the Rack by dragging them from the Component Pool and 

dropping them into any position you want. You can also add the component pre-
configured to produce a particular sound, by dragging a Component Preset into the 
Rack (see section 4.2).

►► When you click on the “empty” space of any rack module (not on any knob or switch), 
it is highlighted by an orange frame, meaning it is selected. 

►► Selected rack modules will be replaced if you double-click on an item in the Component 
Pool. If no rack module is highlighted, double-clicking will add the component to the 
end of the rack.

►► Rearranging rack modules works with drag and drop – just click on some empty area 
of the component and drag while holding the mouse-button. An orange line indicates 
where the component will go when you drop it by releasing the mouse-button.
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	 Drag and drop: The yellow line indicates where the component will be placed after releasing the mouse 	
	 button

►► Rack Tools (Tuner etc.) have a fixed position and cannot be moved or deleted, but they 
can be hidden using the Toolbar.

►► You can remove Components from the rack by highlighting them and pressing DEL 
(Win) / CMD+BACKSPACE (Mac), or by dragging and dropping them anywhere outside 
of the rack. Another option is to choose Delete selected from the context menu, after 
right-clicking the component.

The Rack Module Column
All modules in the rack feature a small column on the right:

	

►► The On/Off button allows for true bypassing of the module – no CPU power is con-
sumed when it is turned off.

►► The – (Minus) button minimizes the module’s display

►► The triangular arrow toggles its expert panel, if available.
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4.2	 Component Presets

GUITAR RIG 4 comes with plenty of factory presets for components, providing a time-
saving alternative to dialing in classic sounds for each component by hand.

4.2.1	 Basics
A Component Preset contains all settings for one single component. After selecting an 
item of the Component Pool, a list of all available Component Presets is displayed below 
in the SideKick.

The Component Pool, showing the Reverb / Delay section
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The entries of this list behave just like components, but all their settings are already ad-
justed to create one particular sound. To add a component readily configured, you can 
double-click or even drag and drop a Component Preset anywhere into the Rack.

Component Presets and the Rack
Each rack module displays the name of its current Component Preset in a small box on 
its left hand side, the Component Preset Display. It is also a direct link between Rack and 
Component Presets, swiftly taking you to the according list when you click on it.

Double-clicking the Component Preset in the Component Pool has the same effect as 
double-clicking a basic component, depending on the state of the Rack:

►► If no rack module is highlighted, the component will be added to the end of the rack 
with the stored settings.

►► If a different component is highlighted, it will be replaced with the new, pre-configured 
component.

►► If the same component is highlighted in the rack, its settings will be updated with the 
Component Preset. This is useful if you quickly want to check out different settings 
of a component in the context of your current rack.
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Saving Component Presets
Once you have found a good setting for components you use regularly, you will want to 
save your own Component Preset. This is easy: Just click on the triangular arrow right of 
the Component Preset display and select Save As from the context menu.

This will create a new entry in the according list of Component Presets. Type in a name, 
hit ENTER, and you are done! To save any changes to the preset currently displayed, select 
Save from the same context menu.

To delete or rename a Component Preset, right-click on its name in the list and choose 
from the context menu accordingly.
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4.2.2	 Advanced Usage

Sorting and Rating
By clicking on the column headers of the list of Component Presets, you can sort it by 
List Number (#), Name, and Rating. The latter is very helpful to seperate the wheat from the 
chaff: Save a quality rating with each preset by clicking on one of the 5 dots right beside 
its name. This can always be changed later.

Component Preset Banks
As soon as you’ve collected a dozen of your own Component Presets, you might welcome 
a possibility to organize them, e.g. by setting them apart from the factory presets in a list 
of their own. This is where Component Preset Banks can help you.

Each Component Preset is already part of a bank, indicated by the headline between the 
Component Pool and the Component Preset List. The right box (equipped with an arrow) 
displays the name of the Component Preset Bank shown below. If you click on it, a context 
menu appears, giving you the options Add Bank, Delete Bank and Rename Bank, and all 
are doing what they say.

If multiple banks are present, you can select one from this context menu by clicking on 
its name.
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5	 The Rack Tools
The following sections will introduce you to the Rack Tools of GUITAR RIG 4: Tapedeck 
Pre and Post, Tuner and Metronome. All of them are useful, but the latter is especially 
important, as it is the centre of GUITAR RIG’s ability to synchronize.

5.1	 Tapedeck Pre

Tapedeck Pre is the tool for playing back and recording audio at the beginning of GUITAR 
RIG’s signal chain (except when Play at output is activated). Thus, the Tapedeck Pre picks 
up the dry, unprocessed sound, enabling you to change the sound of your recording later. 
Playing a file back in Tapedeck Pre sends it through all modules currently in the Rack.

Tapedeck Pre is capable of changing your tempo during playback without changing pitch 
and vice versa. This is great for learning licks by slowing them down, or changing the 
tempo on backing loops.

5.1.1	 Playback
►► The easiest way to load sound files into the Tapedeck is to drag and drop them di-

rectly onto the component. To browse through your files, click on the Load button.

►► The Tapedecks can play WAV, AIFF and MP3 files up to a resolution of 16bit.

►► Click on the Play button to start playback from the current position of the Transport 
slider. Click on the Stop button to stop playback.

►► If Play at Output is selected, the sound will not be processed, but directly played in 
front of the Tapedeck Post, wich allows for overdubbing (explained below).

►► Adjust the Volume fader to set the playback level. If the Limiter LED lights up, reduce 
the volume to avoid overload.
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You can create a loop to repeat a certain portion of the file over and over:

►► If the Loop button (right to the Stop button) is pressed, playback will be looped.

►► The starting and ending points of the loop are defined by the Start and Stop sliders 
above the Transport slider, which can be dragged with the mouse.

►► Alternatively, you can set these points “on the fly” by pressing the Loop in and Loop 
out buttons during playback.

There are some controls providing special playback options which can be very useful for 
practising, or when using backing tracks:

►► Transpose transposes pitch from – 12 semitones to +12 semitones.

►► Tune allows fine tuning over the range of –50 cents to +50 cents.

►► Tempo will change the playback speed from 50% of the original tempo to 150% of the 
original tempo.

5.1.2	 Recording
►► If no other file is loaded, click on the Record button to activate it – pressing the Play 

button now will start recording.

►► To initialize a new file to be recorded, click on the New button in the lower left. This 
will automatically activate the Record button.

►► Click on the Play button and begin recording.

►► To save a file after recording, click on the Disk button. Navigate to the folder where 
you want to save the file. Name the file, and click on the Save button.
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5.2	 Tapedeck Post

Tapedeck Post is the tool for playing back and recording audio at the end of GUITAR RIG’s 
signal chain. Recording your guitar will pick up the processed sound, just as you hear it at 
the output. Use Tapedeck Post if you want to record your guitar part with the actual sound, 
e.g. for using it ”outside of” GUITAR RIG 4.  Files you play back will not be processed, 
which makes Tapedeck Post ideal for playing drumloops and your own backing tracks.

Its controls are similar to Tapedeck Pre, except that it has no Transpose, Tune or Tempo 
controls, nor can you choose between playing at Input or at Output.

5.2.1	 Interaction with Tapedeck Pre
Tapedeck Post is linked with Tapedeck Pre to allow for synchronization and easy transfer-
ral of recordings.

►► When Sync is turned on, the Tapedeck Post starts and stops simultaneously with the 
Tapedeck Pre. This is useful when processing samples with GUITAR RIG, as their tim-
ing is kept intact.

►► You can easily transfer a recording from Tapedeck Post to Tapedeck Pre by clicking 
on the Transfer... button.



Application Reference – 39

5.2.2	 Recording Overdubs
►► As Tapedeck Pre can play its file at the end of the signal chain, but before Tapedeck 

Post, you can easily record sketches on multiple tracks using overdubbing. Make sure 
both tapedecks are visible by clicking on the buttons in the Toolbar.

►► Record a track in Tapedeck Post, as explained above. Send it to Tapedeck Pre by 
clicking on the Transfer... button. Alternatively, load a file in Tapedeck Pre which you 
want to overdub.

►► Select Play at Output on Tapedeck Pre.

►► Turn on Sync on Tapedeck Post.

►► On Tapedeck Post, click on the New button to create an empty track. Click the Play 
button to record your second track as an overdub. 

►► If you want to overdub again, click on the Transfer... button and repeat the described 
procedure.

►► After overdubbing as many takes as you want, you can save your work as described 
above. 
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5.3	 Tuner

Get in tune quickly and accurately! Besides simple and precise tuning, the Tuner offers 
presets for common tunings in a dropdown menu on its left hand side: Chromatic, Bass, 
Open D / E / G / A, and DADGAD tuning.

The Cent / Strobe buttons switch between two tuning modes:

►► In Cent mode, a small indicator shows whether the pitch is sharp (right of the meter’s 
center point) or flat (left of the meter’s center point). The number left of the display 
indicates the number of the string being tuned. When a string is in tune, the indicator 
sits in the middle of the meter and turns blue.

►► In Strobe mode, a series of lights moves to the right when the string is sharp, and to 
the left when the string is flat. The faster they move, the more out of tune the string. 
When the lights stop moving, the string is in tune.

The Mute Sound button does what it says and is especially convenient when using the 
tuner live and not wanting to disturb the audience or your fellow band members.

Click on the Arrow button to show the tuners expert panel:

►► Reference Pitch sets the tuning reference, from A=425Hz to A=455Hz. The exact pitch 
is shown while you drag the knob.

►► Cents shows the deviation from ideal tuning in cents.

►► Tune transposes the tuning range. If you e.g. want to tune all strings a semitone lower, 
set drop tune to -1.

►► Tune Fork produces a reference tone. To select its pitch, click on the note field to the 
right and drag up or down, or click on the Arrow buttons.
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5.4	 Metronome and Synchronization

The Metronome is not only for keeping yourself in time, but it also serves as the clock for 
all synchronized rack modules, such as modulation and delay effects.

If you are not in Sync mode (see below), you can set the tempo yourself several ways:

►► Dial in any tempo between 20 and 400 beats per minute by clicking on the BPM 
display and dragging up or down, clicking on the arrows, or by double-clicking and 
entering the number directly.

►► Click on the Tap button repeatedly. The Metronome will determine your average speed 
and set the BPM control accordingly. It is very convenient to assign this button to a 
foot controller (see section 9.1 to see how) to actually tap the tempo.

►► You can choose different time signatures using the dropdown menu besides the Signat. 
display. The time signature determines the relation between downbeats and offbeats.

►► If the Mute button is not pressed, this is reflected in the succession of sounds #1 and 
#2, as defined in the boxes below:

►► #1 is the sound played on downbeats and strong beat divisions.

►► #2 is the sound played on weak beats.

You can change both sounds to any .WAV file you want by clicking on the respective Load 
button

The Sync setting defines if the Metronome obtains its tempo setting from any other source. 
The three available sync settings are:

►► Ext: When in plug-in mode, the Metronome is synchronized to the host’s tempo, to 
the external MIDI clock when in stand-alone mode. All controls for setting the tempo 
are disabled.
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►► Sound: The current tempo is stored with the Rack content when you save a preset. In 
this setting, the Metronome loads the tempo information when you load a preset. This 
is useful for preparing presets with synchronized effects e.g. for a live show.

►► Free: This effectively turns host and preset synchronization off. The Metronome can 
run freely at the tempo you set, independent of the preset loaded or the host’s tempo. 
It is still giving the clock for all synchronized effects in the rack, and the current 
tempo is still saved with the preset!

The Mute button and the Volume knob serve to adjust the volume of the Metronome sound 
or to mute it.

5.5	 Preset Volume

The sound of many of GUITAR RIG’s components is highly sensitive to the level of their 
input signal and their volume setting – just think of an amp being overdriven. This is com-
monly used for the sake of sound design, resulting in volume differences between presets.

Thus, you might want to adjust the overall volume of your Rack to achieve the same Output 
Level for different presets. This is exactly what the Preset Volume does: Simply adjust 
the big volume fader after you have found the sound you were looking for – its position is 
automatically saved with your preset.

The Learn button automatically sets the optimum Preset Volume: After clicking on it, just 
play loudly for a little while until it automatically pops out.
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6	 The Rig Kontrol
This section is about the integration of GUITAR RIG with the RIG KONTROL pedalboard – if 
this does not concern you, you can just skip it. To learn how to assign your MIDI controller 
to the Virtual Rig Kontrol, refer to section 8.1.3.

The RIG KONTROL is a fully integrated hardware solution for using and controlling GUITAR 
RIG 4. Nine freely assignable knobs and an expression pedal are at your disposal right after 
connecting it. Note that you can use the RIG KONTROL to control GUITAR RIG 4, even if 
you do not use it as your audio interface. For detailed information about the hardware and 
how to use the integrated audio interface, refer to the Hardware Reference.

Before you continue, make sure that your Rig Kontrol is connected via USB 2.0 and ac-
tivate the Virtual Rig Kontrol by clicking on its button in the Toolbar. On the Virtual Rig 
Kontrol, each button is headed with an LED indicating its status (on/off). The LED bar left 
of the foot pedal shows the degree to which it is pressed down. The Virtual Rig Kontrol 
provides an expert panel to manage and configure assignments, e.g. to set the range of 
each controlled parameter – see section 3.3 for details.
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6.1	 Activating the Rig Kontrol

The RIG KONTROL is automatically activated in GUITAR RIG the moment it is plugged in. 
When running multiple instances of GUITAR RIG (for example as a plug-in), the last one 
launched is controlled by the RIG KONTROL by default.

To change its focus to the instance you want to control, bring up the Virtual Rig Kontrol 
by clicking on its button in the Toolbar or by pressing F3. By clicking on the Active LED, 
the RIG KONTROL is activated in this particular instance.

6.2	 Assigning Functions to the Rig Kontrol

The labels below the buttons and left of the foot pedal show which function is currently 
assigned to them. The buttons of the RIG KONTROL are best suited for controlling Power 
/ Input Mute buttons and the likes, whereas the pedal is perfect for continuous parameters 
like the wah-wah slider or volume.

Drag and Drop
Assigning functions by yourself is easy with drag and drop:

1.	 Click on one of the labels and drag it anywhere into the Rack. The knob or switch you 
drop it onto is instantly assigned to the button of the Rig Kontrol whose label you 
dragged.
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2.	 If you operate a knob or the pedal of the (physical) RIG KONTROL, both the Virtual 
Rig Kontrol and the assigned function will react to it.

	

	 The label of  Switch 1 is dragged onto the Volume I knob of the Plex.

While dragging, the mouse pointer gives you feedback as to where you can create an as-
signment by showing a small arrow. A No Entry sign is shown at areas where dropping the 
item is not possible. 
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Context Menu
Alternatively, you can use the context menu to browse through all assignable functions: 
just right-click on the label of the switch you want to assign to call it up.

The context menu also offers to remove all of the assignments of a particular control with 
one click on Clear All.

Most importantly, you can choose to Lock this control’s current assignments, protecting 
them from being altered when changing Rack Presets - until you unlock them, again using 
the context menu. The global status of any controller is indicated by the padlock symbol.
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6.3	 Configuring Assignments

The RIG KONTROL’s assignments can be managed in the expert panel of the Virtual Rig 
Kontrol. Click on the arrow button to reveal it, then click on a label or knob on the Virtual 
Rig Kontrol to select it. The functions assigned to this particular control are now shown 
in the expert panel.

Here is what the expert panel can do for you:

►► Assigning functions by dragging and dropping the white label in the upper-left corner.

►► To change the display name for the selected control, change the text in the black field 
on top of the expert panel. This is – regardless of the text in the white label – what is 
shown on the Virtual Rig Kontrol.

►► There are two pages with 4 assignment slots each. If you are using more than 4 as-
signments, click on the button labeled 5-8 to show them.

►► To temporarily deactivate an assignment, click on the tickmark on its left-hand side. 
Click again to reactivate it.

►► To delete an assignment, click on the X (Cross) on its right-hand side. To delete all 
assignments for a particular controller, right-click on its label and select Clear All.
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Mapped Range of Parameters
There is a horizontal line representing the value range of each assignment. To adjust the 
way the controller’s input values are mapped to the assigned parameter, you can click and 
drag the Brackets left and right of the line.

►► The left Bracket defines the value mapped to the controller at zero, the right one the 
value mapped to the controller fully turned up.

►► As switches always send these extreme on/off values, the Brackets can be used to 
define which actual knob positions they trigger. Thus, you can configure a button to 
switch between 12 o’clock and full gain, and so on.

►► Because you can drag the brackets across to the other end, you can even invert the 
mapping, so that, e.g. the assigned knob will be turned down when you push the 
pedal, instead of down. This is useful if you want to assign two different value chang-
es to one control, e.g. increasing gain while turning master volume down.

6.4	 Assigning Functions to External Controllers

You can connect external footswitches or pedals to your RIG KONTROL’s analogue controller 
inputs and easily assign them using the Virtual Rig Kontrol. Please make sure the inputs 
are correctly configured in the Preferences pane (see section 8.2) first.

Activate the expert panel of the Virtual Rig Kontrol by clicking on the arrow button. In the 
upper right corner there are two labels representing your analogue controllers, and they 
behave exactly like the RIG KONTROL labels. The assignment of functions works the same 
as with the internal controls of the RIG KONTROL:

1.	 Click on the arrow button on the Virtual Rig Kontrol to show its expert panel.

2.	 Drag the Pedal 1 or Pedal 2 button onto any function in the Rack.

Important: If the external footswitch you are using is “on” only while pressed (instead of 
switching between “on” and “off”), activate Toggle Mode in the context menu of the ac-
cording input.
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7	 Using Guitar Rig in a Host
GUITAR RIG 4 works within all digital audio workstations (DAWs) that support the VST, 
RTAS or AU plug-in interface. The plug-in is automatically installed.

7.1	 Basics

After installation, you can instantly use GUITAR RIG 4 in your host just like any other plug-
in. The plug-in and the stand-alone version of GUITAR RIG 4 share the same presets and 
settings – any changes you make in one will naturally affect the other!

7.1.1	 Audio and MIDI Setup
In plug-in mode, the audio interface is controlled by the host application, so the Audio 
and MIDI Settings of GUITAR RIG are not effective. Please consult the documentation of 
your DAW on how to set up audio and MIDI. Remember to avoid zero-latency and direct 
monitoring options, as you won’t hear your guitar processed by GUITAR RIG 4 if these are 
turned on.

7.1.2	 Plug-In Location
During the installation of GUITAR RIG 4 on a Windows computer, you need to specify the 
folder where your DAW looks for VST plug-ins. This is where the plug-in file “Guitar Rig 
4.dll” has been copied – you can move it anytime, in case you changed your plug-in folder 
or made a mistake. It might be necessary to re-scan the plug-in folder in your DAW before 
GUITAR RIG 4 appears in the list.

On a Mac, plug-ins are centrally stored in the Library under Audio/Plug-Ins.



Application Reference – 50

7.1.3	 Setting Up a Guitar or Bass Track
To setup a track to be processed by GUITAR RIG 4, just create an audio track and insert 
GUITAR RIG 4 as an effect. The audio track will hold the bare, unprocessed signal and 
your sound will be routed through GUITAR RIG before reaching the output stage of your 
DAW. Thus, you can easily tweak the sound of your guitar or bass tracks after recording 
(re-amping) and even automate the parameters of your sound as a part of your arrange-
ment (see section 4.2).

Attention: Although some programs allow you to plug in GUITAR RIG 4 as a MIDI instru-
ment (because it works both with audio and MIDI), you should use it as a signal processing 
/ effects insert.

7.1.4	 Synchronization
If you want GUITAR RIG 4 to be in time with your host, remember to turn on Ext mode in 
the Metronome (see section 7.4). This will turn off the speed setting of GUITAR RIG and 
use the host’s tempo as a master. This affects all synchronized effects and the modifiers, 
as well as the Metronome itself.

7.1.5	 Total Recall
When using GUITAR RIG 4 within a DAW and you save your project, it will save whatever 
is the current state of GUITAR RIG 4. So, if you using a modified preset (as compared to 
how it is stored), don’t worry – when you next load the project, the rack will be recalled 
exactly as you left it.
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7.2	 Automating Parameters

This section is intended to give a mere introduction to automation and the characteristics 
of GUITAR RIG 4 in this regard. As this is a sequencer subject, please refer to your DAW’s 
documentation to learn how it works with your particular software.

Automation in a sequencer means recording parameter changes: The movements of your 
wah wah pedal, or operating the power switch of the fuzz right before the solo! This can be 
done immediately while you play, e.g. with a foot pedal, or in a separate step afterwards.

Automating parameters is super easy when you use GUITAR RIG 4 as a plug-in! Whether 
you set up your controller hardware in GUITAR RIG or in your host, or if you want to use 
your mouse to control parameters: Any way to move the knobs in GUITAR RIG is a way to 
record automation!

7.2.1	 The Automation List
Please refer to your DAW’s documentation to learn how to show the Automation List for 
the track where the GUITAR RIG 4 plug-in is inserted. All parameters of components that 
are currently in your Rack are automatically present in the Automation List, so they can 
be addressed by track automation in your sequencer. Check the context menu of any knob 
to see its current automation ID!

The Automation List is limited to 128 slots. Deleting a module from the rack results in 
clearing of the slots it had occupied before. When you add a new one, it tries to fit its 
parameters into the empty spaces within the current Automation List. Only if this is not 
possible, entries will be appended at the end of the list.

Enabling Automation for Rack Tools
The Rack Tools (Metronome, Tapedecks, etc.) can be automated as well, but to save space 
in the Automation List, this is disabled per default. To enable automation for any Rack 
Tool, right-click it, and select Enable Automation from the context menu (only available in 
plug-in mode). Its parameters will instantly appear in the Automation List.

Disabling automation for any component works the same way!
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Rebuilding the Automation List
After you have added and removed numerous components, your Automation List can be 
a bit of a mess. If you want to fill up all the empty spaces, right click any component of 
your Rack (while in plug-in mode) and select Rebuild Automation List from the context 
menu. Mind that all your previously recorded automation might be assigned to a wrong 
component now, as a result of their changing positions in the Automation List.

7.2.2	 Automating Parameters in Apple Logic Pro
This example explains how to work with Apple Logic Pro, but all other DAW software 
operates in a similar fashion. Please refer to the documentation for your DAW for more 
information on the specifics of your host.

1.	 In the View menu, turn on track automation for the selected track, so you can see 
what you are doing.

2.	 Change the track to Latch or Touch mode

3.	 Start playback.

4.	 Move the desired control(s) of GUITAR RIG using the RIG KONTROL, any MIDI control-
ler or your mouse.

The automation will be recorded automatically as you play back the track. Of course, you 
can also use the pencil tool to draw automation by hand!
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8	 Options
The Options tab gives access to two areas: Controller assignments and general Preferences 
for configuring the application.

8.1	 Controller

This page lets you set up and manage your external MIDI controller assignments. Before 
you continue, please make sure that your MIDI interface is activated in the Audio and 
MIDI Settings... (see section 9.1). Also check if the correct MIDI channel is selected on the 
Preferences tab (see section 8.2). Note that Guitar Rig 4 reacts to MIDI Program Change 
messages regardless of assignments: They switch presets within the current Preset List.
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Controller Assignment the Easy Way
The quickest way to control any knob with a MIDI device is provided by its context menu:

1.	 Right-click on the knob or fader you want to control.

2.	 Select Learn.

3.	 Operate the external controller. It is instantly linked to the parameter.

A message will appear informing you that a new controller has been added – Guitar Rig 
makes no difference between keyboard shortcuts and MIDI messages! Note that you can 
also clear all assigned controllers using the same context menu.

8.1.1	 Setting up External MIDI Controllers
Each of your device’s controls (knobs, fader, etc.) can be configured via the Controller 
list. You only need to do this once, as the Controller list is global for all presets. Make 
sure you are on the Controller tab of the Options page in the SideKick. Follow these steps 
to add a new MIDI controller:

1.	 Click on the Add Controller button on the bottom of the SideKick to add a new con-
troller entry. Rename it by double-clicking on the white headline bar.

2.	 To link a (physical) device to the controller entry, click on the Learn button and oper-
ate the knob (fader, etc.) you want to link briefly. Its MIDI code will be shown in the 
box right of the button and the Learn button will pop out. It is also possible to assign 
keyboard shortcuts the same way!

If you want to change the device a controller is linked to, just click Learn again and oper-
ate the desired knob.
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Important: If the MIDI footswitch you are using is sending “on” only while it is pressed 
(instead of switching between “on” and “off” each time you press it), this will be the be-
havior of the assigned parameter as well. If you want to change it, activate Toggle Mode 
in the Menu of the according controller.

Deleting Controllers
To delete any entry of the Controller list, first select it by clicking once – it is highlighted 
by an orange frame. Then click on the Delete Controller button on the bottom of the 
SideKick.

8.1.2	 Assigning Functions to Controllers
Each controller input can trigger different functions in GUITAR RIG at once. Its assign-
ments are shown below the Controller list entry, each in a separate line.

1.	 To assign a function of GUITAR RIG to the controller, drag its white headline bar onto 
the element (knob, button, fader, etc.) of the Rack that you want to control.

2.	 While dragging, the mouse pointer gives you feedback as to where you can create an 
assignment by showing a small arrow. A No Entry sign is shown where dropping would 
make no sense.

3.	 The function you just assigned is now listed below the according entry in the Controller 
list. More assignments can be added the same way.
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Configuring and Deleting Assignments
►► To temporarily deactivate an assignment, click on the tickmark on its left-hand side.

►► To delete an assignment, click on the X (Cross) on its right-hand side.

►► To delete all assignments for a particular controller, click on the Menu button and 
select Clear All.

►► To adjust the way the controller’s input values are mapped to the assigned function, 
you can click and drag the Brackets left and right of the horizontal line.

►► The left Bracket defines the value mapped to the controller at zero (MIDI value 0), the 
right one the value mapped to the controller fully turned up (MIDI value 127).

►► As switches always send these extreme on/off values, the Brackets can be used to 
define which actual knob positions they trigger.

►► As you can drag the brackets across, you can invert the mapping, so that the assigned 
knob will be turned up when you turn your controller down.

Assigning Functions via Menu
Drag and drop is not the only way for creating controller assignments, the Menu button offers 
an alternative, listing all available functions in a menu-like interface. Click on the Menu but-
ton and navigate through the categories and click on any function to create an assignment.

Even if you prefer drag and drop, the Menu is necessary to assign functions that are not 
controlled by any rack module, e.g. switching presets.
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Global Assignments
By default, all assignments are stored on the preset level, so they change as the preset 
changes. In most cases, this is the expected behavior, but you may wish to have some 
global assignments that are always the same. The most obvious and common case is when 
you assign Sound Selection – Previous / Next to a controller to step through the presets. 

To make any controller’s assignments global (overriding assignments on preset level), click 
on the according Menu button and select Lock (a padlock symbol appears).

Unlock the controller the same way to be able to add or delete assignments.

8.1.3	 Linking External MIDI Controllers to the Virtual Rig Kontrol
The Virtual Rig Kontrol is a perfectly integrated component of GUITAR RIG 4, sporting 
pre-assigned functions for many presets and a convenient display for all its assignments, 
especially in Live view. If your external MIDI controller features a comparable set of con-
trols, it can make sense to map it to the Virtual Rig Kontrol and then use the latter for 
assigning functions instead.

Linking its knobs and the pedal to any controller input works exactly the same as with other 
functions: Just drag the controller and drop it onto the button of the Virtual Rig Kontrol 
you want it to be linked with. All the functions assigned to this particular button will now 
be triggered by the linked controller input. Assigning functions to the Virtual Rig Kontrol 
works by dragging the box below or beneath each of its controls (containing its name) onto 
the desired knob or switch in the rack. See section 6.2 to learn more!
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8.2	 Preferences

On the Options tab, click on Preferences to call up the control center for configuring GUITAR 
RIG 4. 

It offers the following settings:

►► Window Height: Use this control to set the height of the GUITAR RIG 4 window. You 
can choose among Small, Medium or Large. The actual dimensions in pixels (given in 
brackets) depend on the physical display resolution of your monitor.

►► MIDI Channel: Set the channel on which GUITAR RIG listens for incoming MIDI mes-
sages. Choose Omni if you want it to listen on all channels.

►► MIDI Learn Popup Window: Toggles whether or not the MIDI Learn Window will pop 
up after each MIDI assignment you make.

►► Show Help Hints: Toggles whether hints appear when the mouse is hovering over 
control elements.
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►► Scan For New Presets: Updates the preset database. Use if you copied files to the 
preset folder manually or created new presets using KORE2.

►► Restore Factory Content: If you accidentally deleted or changed any of the presets that 
came with GUITAR RIG 4, you can make a fresh start. Your own presets remain unaf-
fected. 

►► Import GR3 Content: Select to scan for GUITAR RIG 3 presets and component tem-
plates.

►► Virtual Rig Kontrol Style: You can adapt the appearance of the Virtual Rig Kontrol, if 
you are using the silver RIG KONTROL 2.

►► Rig Kontrol 1: Turn on to activate compatibility mode for the blue RIG KONTROL 1.

►► Rig Kontrol Pedal Parameter Mode: Controls with which value the pedal and its as-
signed parameters are initiated when a preset is loaded: The actual current position 
the pedal is in (Pedal Mode) or the one stored with the preset (Preset Mode).

►► Rig Kontrol Pedal Calibration: If your RIG KONTROL pedal does not behave as in-
tended, click Reset, and follow the instructions to recalibrate it.

►► Rig Kontrol Ext. Pedals Calibration: If the external pedals connected to your RIG 
KONTROL do not behave as intended, click Reset, and follow the instructions to reca-
librate them.

►► Rig Kontrol 3 Ext. Pedal 1/2 Mode: Use this menu to adjust the Rig Kontrol to differ-
ent types of external pedals or footswitches. Please refer to the documentation of your 
pedal / footswitch to find out the correct setting. If it doesn’t work, just try out the 
other setting.
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9	 Program Menu
GUITAR RIG 4 is designed in a way that – once set up – you will hardly ever need to use 
the Program Menu. Most of its functions are easier accessible another way, as explained 
above. However, it may be necessary to change the Audio and MIDI settings... in standalone 
mode, and all the GUITAR RIG 4 documentation is conveniently linked in the Help menu.

9.1	 File

New Sound
Creates an empty new preset. Just enter a name, press Save and fill the Rack with your 
components of choice!

Save Sound
Has the same effect as clicking on Save in the Preset Browser. Saves changes to the cur-
rently loaded preset.

Save Sound As...
Has the same effect as clicking on Save as... in the Preset Browser. Saves the current rack 
as a new preset.

Import
Allows to import GUITAR RIG 3 and 4 presets into the Preset Browser. This option lets 
you browse for preset files with the extension .ksd. An easier way to import is to just drag 
and drop the files into the Preset Browser. Note that, depending on the components and 
settings used, GUITAR RIG 3 presets might sound a bit different – to the better, we hope!
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Audio and MIDI Settings...
To configure the audio and MIDI system of GUITAR RIG 4 for standalone use. See section 
10 for details.

Exit
Quits the application.

9.2	 Edit

Undo
Allows to take back the last operations, including destructive errors like clearing the whole 
rack.

Redo
Repeats the last undone step.

Cut / Copy / Paste / Delete / Select All
Performs the standard edit operations in the current context: Copy and paste rack modules, 
select all or delete entries from the Preset List, and so on. The action performed depends 
on the currently selected area of the user interface, i.e. where you last clicked.
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9.3	 View

Hide / Show Hints
Has the same effect as the according option in the Preferences. Disables or enables the 
helpful hints shown when the mouse is hovering over control elements.

Full Screen
Activates full screen mode, giving you the maximum possible resolution - extremely useful 
in Live view. Press ESC or F4 to return to normal mode.

Hide / Show SideKick
Hides or shows the left area of the GUITAR RIG 4 user interface, where Preset Browser, 
Components Browser and Options are displayed.

Hide / Show LiveView
Has the same effect as clicking on the Live button. Activates or deactivates Live view.

Hide / Show Rig Kontrol
Has the same effect as clicking on the Virtual Rig Kontrol button. Hides or shows the 
Virtual Rig Kontrol.
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9.4	 Help

Launch Service Center...
Starts the Native Instruments Service Center – for activating the application and down-
loading updates. Read the Setup Guide for more information!

Activate Guitar Rig 4...
Starts the Native Instruments Service Center, directly taking you to the Activation tab.

Open Manual...
For access to all available manuals, navigate to your language.

Visit Guitar Rig 4 on the web...
Your permanent bookmark to the GUITAR RIG 4 website, where you find product-related 
resources, news and entertaining extras!

Visit the Knowledge Base...
Another extremely useful bookmark leads to the Knowledge Base, your primary source for 
troubleshooting and sharing technical experiences with GUITAR RIG 4.

About Guitar Rig 4
Brings up the About-Screen, giving information about the software version, your registra-
tion number and the creators of GUITAR RIG 4.
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10	 Audio and MIDI Settings
This section explains how to configure GUITAR RIG’s Audio and MIDI Settings.

10.1	Audio

Driver
Choose the correct type of driver for your audio interface. Using ASIO (Windows) / CoreAudio 
(MacOS) is strongly recommended.

Device
Select your audio device from the list. If it doesn’t appear, check if it is connected and 
its drivers are properly installed.
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Status
Shows the current status of the selected audio interface, which should be Running. If it 
says Stopped, please consult the documentation of your audio interface. Check if it is 
connected and if its drivers are properly installed.

Sample Rate
Choose the desired sample rate for audio processing, the standard is 44100 Hz. Higher 
sample rates may result in higher quality, but they definitely consume more CPU power.

Latency
Latency is the time that passes between the moment you hit a note and the moment you 
hear it. It is caused by several stages of data transfer and audio processing, which all con-
sume a small amount of time. The latency allowed for processing can be adjusted within 
a certain range, but the lower you go, the higher the probability of processing errors gets. 
All depends on your processing power and the quality of your audio drivers! It is strongly 
recommended to consult the documentation of your audio interface to learn more.

►► On a Windows Computer, click on the ASIO Config button to change the latency. Your 
audio driver’s setup window will be called up.

►► On a Mac, latency is set directly in the Audio and MIDI Settings. Use the Latency 
slider to try out how low you can go. Play while you are moving it, and watch out for 
crackles, pops and dropouts. If they occur, your latency is set too low.

The latency value is given in samples, its time value can be calculated easily: Divide the 
number of samples by the sample rate (samples/s) and you get the processing latency 
in seconds. To spare you the trouble, the three major stages of latency are calculated in 
the Audio and MIDI Settings window automatically, as well as the resulting overall latency 
in milliseconds. Note that this value might be higher than what you’re used to, because 
often, you are only given the internal buffer size in ms, instead of the real overall latency.



Application Reference – 66

10.2	Routing

If you want to invert the Input or Output channels or set up a special routing  for multi-
channel setups, this is the place to go. The left column shows the available channels of your 
audio interface. The entries in the right column are actually menus. By clicking on them, 
you can assign the left and right channels of GUITAR RIG 4 to any of your audio interfaces 
channels. This is done separately for Input and Output. Be careful, as a misconfiguration 
of the Routing table may lead to not hearing any output anymore.

10.3	MIDI

The left column shows all available MIDI devices , sorted by Input and Output. The entries 
in the right column are actually menus. By clicking on them, you can turn them on or 
off. Mind that any devices you want to use to control GUITAR RIG 4 have to be activated 
(turned On) under Input.
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